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Welcome!
Thank you for using Merlin Server; the system for sharing Merlin Project documents to
Mac, iPhone, iPad or even Windows users.
This is the Merlin Server documentation.

Download, Test & License
Help and support
For help and support please use the Help menu.



You may also visit the Support section on our website:
www.projectwizards.net or email our support team
support@projectwizards.net.
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System requirements
Merlin Server requires an Apple Mac with Intel processor and macOS 10.12 as a
minimum.

Installation
• Download the latest version of Merlin Server from our website.
• Double-click the program icon to open it.
• Confirm the installation.

• Clicking the button "Move to Applications Folder".

• Enter your administrator password.

• Merlin Server will install its components and start afterwards automatically.
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System requirements

Check Installation
Call the Merlin Server menu and select the »Check Installation…« option. This option
checks your Merlin Server installation and the required access rights.



Before doing this, stop Merlin Server. Please note that this process
disconnects all active users from the server.

Checking the installation produces a report. This includes potential issues and, for
instance, incorrect or missing permissions.

You can save the results for troubleshooting reasons.
Click »Save…« and create a file with the results. This file can be forwarded to our support
team.
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30-Day Trial
Merlin Server needs to be activated by a license file. If you do not have a license file, you
can test Merlin Server absolutely free of charge for 30 days.
Once you have downloaded and installed Merlin Server you will see this dialog.

Click »Start 30-day trial«. This starts your 30-day, zero-restriction demo.
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30-Day Trial

Click the blue banner to access additional demo-period options.

Click »Manage Licenses« if you have a license and want to install it right away.

License
In the »Licenses« area you can manage your license(s).

Click the »+« to import purchased license files.



If you have misplaced your purchased license file(s) for Merlin Server,
click »Lost License« to request a new copy over our website.

Once the demo period has ended, Merlin Server will no longer be licensed. This is
indicated by the blue banner »Not licensed«.
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If Merlin Server is unlicensed, the services will be inactive. You can tell this from the red
icons.

Click the banner to buy a new license.
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License

Overview of Merlin Server
Window
The window of Merlin Server is divided into the sidebar (1) and the main area (2).

In the sidebar you find all the functions, which are divided into services and servers.
The main area contains all the options for controlling the functions previously selected in
the sidebar (1).
The server window is always displayed in its default size. To change the height and width
of the window, use your mouse and drag the sides.
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Menus
Merlin Server features menu options and associated keyboard shortcuts. These are as
follows.

Merlin Server
The menu »Merlin Server« includes options provided by the operating system for all
applications. It also includes options for uninstalling Merlin Server and checking the
installation.

The menu »Merlin Server« includes the following menu options:
• About Merlin Server
• Services > Services Preferences
• Hide Merlin Server
• Hide Others
• Show All
• Check For Updates…
• Uninstall…
• Check Installation…
• Quit Merlin Server [cmd + Q]



Quitting Merlin Server quits the app and leaves any activated services
active.

File
The menu »File« includes an option which closes Merlin Server, although all activated
services remain active.
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Menus

• Close [cmd + W]

Edit
The menu »Edit« includes options provided by the operating system.
When selecting text areas or text fields, the majority of those options become available.
Several options remain grayed out.

View
The menu »View« allows you to quickly switch to individual areas in Merlin Server.
Select the desired area, or use the associated keyboard shortcuts.

Services
• Sync [cmd + 1]
◦ Documents [cmd + 2]
• Publishing [cmd + 3]
◦ Accounts [cmd + 4]
• Web [cmd + 5]
Server
• Certificates [cmd + 6]
• Licenses [cmd + 7]
• Tenants [cmd + 8]
Enter Full Screen

Window
The menu »Window« includes options provided by the operating system managing the
window.
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• Minimize [cmd + M]
• Bring All to Front
• √ Merlin Server

Help
The menu »Help« includes following options:

• Search
• Merlin Server Help [cmd + ?]
• Create Support Profile…
Search
Use this option to search for the individual menu options within the application and this
help guide.
Merlin Server Help
This option calls this help guide.
Create Support Profile…
Call the »Create Support Profile…« option to create a Support Profile, which can help our
support team for troubleshooting reasons.

10

Menus

Sync
The »Sync« service is responsible for synchronization and is required for the »Publishing«
and »Web« services in Merlin Server.

The Sync service in Merlin Server has the following information and options:
• On/Off switch
• Status and link
• Last access with log
• Connected users
• IP-Addresses
• Port
• Hostname
• Master Password

Switching On/Off
To activate the sync service, click the Off button or move the slider to the right using your
mouse.
Merlin Server will then start the sync service in a few moments. The slider will stay in the
On position and the status will change from Stopped to Available.



If you already used Merlin Server on the Mac with multiple services at
the same time, you will be notified to restart all the services
simultaneously.
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Status
The status indicator tells you about the availability of the sync service and its current
availability.

To make changes to the service settings, the setting must be stopped.
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Status

The service is enabled and available locally.



You may enter forwarding rules on your router for the Merlin Sync Server
port 7190, to make this service available on the internet. You’ll find more
related information here.

Link
The »Link« option has two functions.

• Open in
• Copy for
Clicking the Open in option opens Merlin Project on your Mac and displays the window
Merlin Server - Documents.
With the Copy for option, you create a clipboard link to the current service path. You can
paste this link into any program, such as Mail, TextEdit, Notes or similar, using the option
Edit > Paste or cmd + V and share it with other participants.

Reference Guide | Merlin Server

13

Last Access
The option Last access shows a user’s most recent activity in the sync service.
Please refer to the Console.app supplied with OS X for further information on the sync
service. To do this, click the Show Log button.

The Console.app includes a variety of information on the sync service. You can select this
in the sidebar. Access attempts are saved in »access.log« files.
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Last Access



Errors are logged in »access.log« files.

Connected Users
Current service use is displayed here depending on the number of users in the license
purchased for Merlin Server. By default, 5 users are supported simultaneously in Merlin
Server using the smallest license.



The number of open files is irrelevant. It concerns the individual users
who are connected simultaneously to Merlin Server. Please refer to your
Merlin Service license for the maximum number of users.

IP Addresses



Switch the sync service off to make changes to the following option.

The option »IP-Addresses« lets you set the IP addresses which Merlin Server should use.
The IP addresses are active addresses from the network services active on your Mac.
This option can be helpful when using VPN, Wi-Fi, Ethernet, and other network services.
All active addresses are used by default. Select or deselect the target IP address by using
the drop-down menu.
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The active network services can be found in OS X by going to System
Preferences > Network.

Port



Switch the Web service off to make changes to the following option.

Merlin Server uses the Port 7190 for the sync service. If the port is already used in your
company, you can set another port for the sync service.

Hostname



Switch the sync service off to make changes to the following option.

The hostname of the sync service is adopted automatically when no explicit hostname is
used. If you want to use your own hostname, click the Edit button.



The hostname must be valid and resolvable in the network.

Then select the option »Use hostname« and enter an IP address or a dedicated hostname
in the field.

Master Password
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Switch the sync service off to make changes to the following option.

Port

The »Master Password« protects you from unauthorized third-party access. Should you
choose to setup Merlin Server on more than one macs, and want to access from another
mac this Merlin Server sync service, this is the password you need to enter there when
selecting this data source.
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Documents
In the »Documents« area, you can manage the documents the sync service has available
to users.

Add new documents
There are several ways to add documents to the sync service.
Plus Icon
Click the plus icon on the bottom left.
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Documents

You can choose between two options:
• Publish Documents…
• New Folder
Click »Publish Documents…« and then on one or more documents supported by Merlin
Server.

To publish the selection, click the »Publish« button.
Drag & Drop

Drag one or more documents into the window field.
When you start the sync service, these documents will be available to all users with
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appropriate document permissions.



You can add documents while the sync service is running, so there is no
need to switch it off.

Create New Folder
You can manage documents in Merlin Server using folders. Create a new folder by clicking
the plus icon and selecting the option »New Folder«.

Name the new folder and then populate the folder with documents.

Delete Documents/Folders
Select one or more documents from the list and either press the delete key on your
keyboard or click the minus icon on the bottom left.
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Documents

Confirm the deletion process.



You can delete documents while the sync service is running, so there is
no need to switch it off.

Remote management password

If you want to grant the permission to Merlin Project users of sharing and managing
documents of this server, you need to enter a remote management password. Just click
the »Remote Management Password« button on the bottom right. and share the newly
created remote management password with those users.
To change the remote management password, follow the same steps as for creating a new
password.
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Link

Right-click a document in the list. You can choose between two options:
• Open link in
• Copy link for
The option Open link in lets you open the document in Merlin Project.
The option Copy link for lets you create a link to the document in the clipboard. Open any
text program (such as Mail or TextEdit) to paste the link into it using File > Paste or cmd +
V.
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Documents

Publishing
The »Publishing« service is responsible for unattended publishing actions over the
configured Accounts of Merlin Server.
The Publishing service in Merlin Server has following information and options:

• On/Off switch
• Status
• Next attempt
• Last success with log
• Data source



Publishing requires an active »Sync« service as well as at least one
configured publishing service.

Switching On/Off
To activate the publishing function, click the Off button or move the slider to the right
using your mouse.
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Merlin Server will start publishing in a few seconds. The slider will stay in the On position
and the status will change from Stopped to Running.

Status
The status tells you about the activity of the service. Green means the service is active.

Next attempt
Next attempt shows you the time when Merlin Server will republish the data.
The Show Log button opens the console app and the logs saved within it concerning the
publishing service.

Last Success
Last success shows you the time when Merlin Server last successfully published the data.
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Status

Data Source
This option tells you whether the service on the Merlin Server used by you or another
Merlin Server installation is acting as the »data source«.
Click the Edit button to use a different data source.



Should you need to select another sync service from another Merlin
Server, click Sync service from a different Merlin Server installation and
enter the URL and master password of that Merlin Server.
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Accounts
To use the »Publishing« service you’ll need to configure at least one publishing account.

Merlin Server offers three different accounts for publishing:
• FTP
• SMTP
• WebDAV

Click the »+« icon to add a new publishing account or click the »-« icon to delete the
selected account.
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Accounts

FTP
Click the »+« icon and then click FTP from the menu.

Doing so creates a new FTP account for publishing.
The following configuration settings are available for the FTP account:
• Name
• Server Address
• Port
• Path
• User name
• Password
The »Connection status« tells you whether you are connected to the FTP server. Check
the settings for any input errors, etc.

SMTP
Click the »+« icon and then click SMTP from the menu.
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Doing so creates a new SMTP account for publishing.
The following configuration settings are available for the SMTP account:
• Name
• Server Address
• Port
• User name
• Password
The »Connection status« tells you whether you are connected to the SMTP server. Check
the settings for any input errors, etc.

WebDAV
Click the »+« icon and then click WebDAV from the menu.
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Accounts

Doing so creates a new WebDAV account for publishing.
The following configuration settings are available for the WebDAV account:
• Name
• Server Address
• Port
• Path
• User name
• Password
• Encryption
The »Connection status« tells you whether you are connected to the WebDAV server.
Check the settings for any input errors, etc.
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Web
The »Web« service allows Merlin Server documents to be accessed via a Web browser.



The Web service requires an active »Sync« service.

The »Web« service in Merlin Server has the following information and options:
• On/Off switch
• Status and link
• Last access with log
• Connected users
• IP-Addresses
• Port
• Hostname
• Data Source

Switching On/Off
To activate the Web service, click the Off button or move the slider to the right using your
mouse.
Merlin Server will then start the Web service in a few moments. The slider will stay in the
On position and the status will change from Stopped to Available.

Status
The status indicator tells you about the availability of the Web service and its current
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Web

availability.

To make changes to the service settings, the setting must be stopped.

The service is enabled and available locally.



You may enter forwarding rules on your router for the Merlin Server web
port 7180, to make this service available on the internet. You’ll find more
related information here.

Link
The »Link« option has two functions.
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• Open in
• Copy for
Open in
The Open in opens your default Web browser and you can see the document window in
your browser.
As long as your Merlin Server is using the self-signed certificate, a warning shown will be
displayed the first time someone accesses it in a Web browser.
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Click Show Details, view the certificate to be sure it is pointing to your
Merlin Server and click visit this website to trust this certificate once.

Link

Documents can be password protected by Merlin Project user resources. Documents
without user resources are directly visible in the web browser and can be opened.
Documents with a password protection require a login and are marked with an appropriate
icon.

Click Login to view the password-protected documents. Log in to the document using the
user’s name and password defined in the documents.
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Hidden documents can be made visible only once you have logged in.

Copy for
With the Copy for option, you create a clipboard link to the current Web service path. You
can paste this link into any program, such as Mail, TextEdit or similar, using the option Edit
> Paste or cmd + V and share it with other participants.

Last Access
The option Last access shows a user’s most recent activity in the Web service.
Please refer to the Console.app supplied with OS X for further information on the Web
service. To do this, click the Show Log button.
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Last Access

The Console.app includes a variety of information on the Web service. You can select
these in the sidebar. Access attempts are saved in »access.log« files.



Errors are logged in »access.log« files.

Connected Users
Current service use is displayed here depending on the number of users in the license
purchased for Merlin Server. By default, 5 users are supported simultaneously in Merlin
Server using the smallest license.
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The number of open files is irrelevant. It concerns the individual users
who are connected simultaneously to Merlin Server. Please refer to your
Merlin Service license for the maximum number of users.

IP Addresses



Switch the Web service off to make changes to the following option.

The option »IP-Addresses« lets you set the IP addresses which Merlin Server should use.
The IP addresses are active addresses from the network services active on your Mac.
This option can be helpful when using VPN, Wi-Fi, Ethernet, and other network services.
All active addresses are used by default. Select or deselect the target IP address by using
the drop-down menu.



The active network services can be found in OS X by going to System
Preferences > Network.

Port



Switch the Web service off to make changes to the following option.

Merlin Server uses the Port 7180 for the Web service. If the port is already used in your
company, you can set another port for the Web service.

Hostname



Switch the Web service off to make changes to the following option.

The hostname of the Web service is adopted automatically when no explicit hostname is
used. If you want to use your own hostname, click the Edit button.
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The hostname must be valid and resolvable in the network.

IP Addresses

Then select the option »Use hostname« and enter an IP address or a dedicated hostname
in the field.

Data Source



Switch the Web service off to make changes to the following option.

This option tells you whether the Web service on the Merlin Server used by you or another
Merlin Server installation is acting as the »data source«.
Click the Edit button to use a different data source.
The local sync service is activated by default.
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Should you need to select another sync service from another Merlin
Server, click Sync service from a different Merlin Server installation and
enter the URL of that Merlin Server.

Data Source

Certificates
In the »Certificates« area you can manage your own certificates for Merlin Server.



Stop Merlin Server to change or create certificates.

Click the »+« icon. You will find two options in the drop-down menu.

• Create a Certificate Identity…
• Import a Certificate Identity…
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Create a Certificate
This option lets you create your own, self signed certificate. In the dialog, enter the
hostname for the certificate and a validity in days.

Import a Certificate
This option lets you import certificates with a private key or public certificates in the form
of files.

Following formats are supported: .p12, .pem, .crt, .cer and .key
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Create a Certificate

Delete Certificates
Use the mouse to select one or more certificates from the list and press the delete key on
the keyboard or click the »-« icon.
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Licenses
In the »Licenses« area you can manage your license(s).

Insert Licenses
Click the »+« to import purchased license files.



If you have misplaced your purchased license file(s) for Merlin Server,
click »Lost License« to request a new copy over our website.

Remove Licenses
Click the »-« to remove installed license files.



You can not remove the automatic created license for the trial period.

Buy Licenses
Once the demo period has ended, Merlin Server will no longer be licensed. This is
indicated by the blue banner »Not licensed«.
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Licenses

If Merlin Server is unlicensed, the services will be inactive. You can tell this from the red
icons.

Click the banner to buy a new license.
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Tenants
The tenants option is for users who want to offer the services of a single Merlin Server to
multiple customers (tenants).

Request Quote
If you are interested, please contact our Sales team for a quote. To do this, simply click the
»Request Quote« button.
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An active »Sync« service is required.

Tenants

Uninstall
Uninstall menu option
The easiest way to uninstall Merlin Server is via the menu option Merlin Server > Uninstall.
When you use this option, following dialog will appear.

Click the button Uninstall to move Merlin Server and the project files used by Merlin Server
to the trash.



If Merlin Server is still running, an error message will appear. Stop all
Server services to uninstall Merlin Server or use Uninstall (force)….

To force uninstall, press and hold the »alt« key while calling the menu Merlin Server. The
option Uninstall (force)… will be visible.



Uninstall (force)… uninstalls and disconnects all active users from the
server.

Manual uninstall
Merlin Server creates and requires files from various system paths:
• /Library/Application Support/net.projectwizards.MerlinServer
This folder contains folders with documents and files for the individual services.
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• /Library/PrivilegedHelperTools/net.projectwizards.MerlinServer.Helper
• /Library/LaunchDaemons/net.projectwizards.MerlinServer.Helper.plist
• /Library/LaunchDaemons/net.projectwizards.merlinserver.publishingservice.plist
• /Library/LaunchDaemons/net.projectwizards.merlinserver.syncservice.plist
• /Library/LaunchDaemons/net.projectwizards.merlinserver.webservice.plist
For a manual uninstall, please delete above files and paths and restart your computer.
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Manual uninstall

More…
Configuration tips
For configuration tips or integration points to the Merlin Project apps please visit our
website…

Merlin Project Help
For the documentation to the Merlin Project mac and iOS apps, click here.
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Feedback
This documentation was compiled by ProjectWizards in June 2020. Do you have any
questions or comments? We look forward to hearing from you.
Please email us at support@projectwizards.net
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